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Quick Tour and Tutorial
This quick tour and tutorial will acquaint you with many of Patch Maker's features by taking 
you step-by-step through the creation of a new patch. (In the following, it is assumed that 
you have installed Patch Maker in the directory C:\PMAKER.    If you have chosen to install 
Patch Maker in a different directory, use that directory name instead when C:\PMAKER is 
referred to in the instructions.)

It will take about 15 minutes to complete this tutorial. You can stop working through the 
tutorial at any time and resume it later. Just be sure to save the patch you are working on 
before closing Patch Maker. To resume working on your patch, open the saved patch.

1. Start Patch Maker.

If you haven't already started Patch Maker, do so now by double-clicking on its icon:

You will see an empty window with a menu bar at the top and a toolbar just below the 
menu bar.

2. Add a waveform.

Under the File menu, choose the Open .WAV File... command and open the file C:\PMAKER\
VIOLIN.WAV. The following icon for the waveform will appear near the bottom of the Patch 
Maker window:

You can play the violin waveform by clicking the right mouse button when the mouse cursor
is over its icon. You should hear a very brief violin note when you do this.

3. Create an empty patch.

Under the File menu, choose the New command. A black and white keyboard appears a 
new window. 

You can clean up the Patch Maker window a little by now choosing the Tile command under 
the Window menu.

4. Add the waveform to the patch.

You add waveforms to patches by dragging and dropping their icons onto patch keyboards. 
Move the mouse cursor over the icon.    Click and hold the left mouse button.    While 
continuing to hold the left mouse button down, move the mouse cursor over a point 



somewhere near the middle of the keyboard and release the button when the cursor shape 

changes from  to 

. (Be sure the cursor is over the keyboard and not just in the keyboard window when 
you release the button.) The keyboard now appears yellow with a red border and a red 
rectangle:

The red border indicates the range of notes that the waveform will be used for.    The 
rectangle, which appears on the note where you dropped the waveform, indicates the 
location of its root note.    We will return to these items later in the tutorial.    

You can play the patch now if you want, but it will not sound very good until we do some 
more things to it.    To play the patch, click the right mouse button on one of the keys of the 
keyboard. If you click on the key where the red rectangle is located, the sound you get 
should be just like that of the original .WAV file.

5. Save the patch

We haven't done much yet, but let's save the patch now anyway.    Under the File menu, 
choose the Save As... command. If the Save As... command is grayed out, click the left 
mouse button on the keyboard to make the keyboard window active.    Then choose Save 
As... again.

You can save it with any name that you like, but it is recommended that you give it a name 
that indicates that it is an experiment, for example, C:\PMAKER\TUTORIAL.PAT. 

6. Define a loop region

How are we going to make our little blip of a violin sound like an instrument that can play 
notes of arbitrary length? The trick is to play a part of the waveform (called the loop region)
over and over again. For this to sound good, the ends of the loop region must match 
precisely. If they don't the patch will have horrible buzzes or clicks in it.    Setting up a good 
loop region is often the hardest part of making a patch. Fortunately Patch Manager can 
simplify the process in many cases.

To set up the loop region, click on the toolbar icon that looks like this: 

This brings up the Edit Loop Region dialog.    Now click on the

button to play the patch. Sounds terrible, but that's because we haven't set up our loop 
region properly yet.    The default loop region is half of the entire waveform, which is rarely 
a good choice.    Press the 



button to stop the sound if you wish.

There are two values that determine the loop region: the place where the loop starts and 
the length of the loop. The slider controls in the Edit Loop dialog let you adjust these.    If 
you are playing the patch while you adjust these values then you hear the results 
immediately.

Sometimes the only way to set a loop region is to do it by ear, that is, keep adjusting the 
sliders until the sound quality is good. However, when the sampled sound is highly periodic,
as is the case for our violin, then Patch Maker can help.    Click the button marked 

Patch Maker then briefly analyses the waveform values and suggests a loop length that 
should work, in this case 135.282 samples. To use that value, click the same button, which 
now looks like

If you are not already playing the patch, press the Play button now. It should sound like a 
reasonably good violin note.

Press the  button to close the dialog and save the loop region values.

7. Tune the patch

Our violin is almost certainly way out of tune. Click the tuning icon

on the toolbar and the Adjust Tuning dialog appears.    Under the Play button in this dialog 
are options to play the patch note, a reference tone, or both.    Press Play and select various
combinations of options.    You will no doubt hear that the patch note and the reference tone
are quite different. 

The tuning of the waveform is controlled by the frequency of the root note. There are two 
ways to adjust the root note frequency to get the patch in tune. The first way is to move 
the slider labelled Sample Pitch while playing the waveform until it is at the same pitch as 
the reference tone. The second, and easier way, is to press the Use button under the 
Suggested Frequency label.    (If the button is labelled Find... then press it to analyze the 
waveform and calculate the suggested frequency. Then press the Use button.) The 
suggested frequency is not always the best one, but in the case of our violin patch, it works
just fine.

Press the  button to close the dialog and save the tuning value. You may notice 
that the position of the root note (as indicated by the solid red box on the keyboard) has 
changed, reflecting the new value of the root frequency.

8. Set up the envelope

There is nothing wrong with the default envelope for our patch, but let's look at how to 
adjust it anyway. Click the icon



on the toolbar to bring up the Choose Envelope dialog.

The default selection of "Sustain notes" is appropriate, because we want a violin note to 
continue playing until a note off message is sent.

When a violin note is played, you would expect it to be have a constant volume until it is 
turned off.    This is different from a piano note, for example, where the volume starts to die 
away as soon as it is played. So, choose the "Sustain at constant volume" option under the 
"While note is on..." label.

When a violin note stops playing, the sound dies away almost immediately. So, choose the 
"Reduce volume quickly" option under the "When note is turned off..." label. 

Press the  button to close the dialog and save the evelope values.

9. Adjust vibrato and tremolo

Real violinists use vibrato to give a sustained note a more interesting sound. To add vibrato 
to our patch, click on the icon

on the tool bar to bring up the Edit Vibrato dialog, which lets you adjust the sweep, rate 
and depth of vibrato for the patch.

These values can be adjusted and the effect heard immediately if the  button is 
pressed, You might need to press the 

 and then the Play button for the vibrato to begin. Set the vibrato values as follows:
sweep = 30, rate = 200, depth = 10. Press the 

 button to close the dialog and save the vibrato values.

We could set the tremolo values in a similar manner by clicking the icon

on the tool bar.

10. Adjust the balance

Violins in chamber music or orchestras are usually located on the right (as seen from the 
audience).    So let's set the balance of our patch to the right.    Click the icon

on the toolbar to bring up the Adjust Balance dialog box. Press the  button to hear 
the violin and adjust the Balance slider to move the sound to the right. A value of 11 for 
balance works well.



Click the  button to close the dialog and save the balance value.

11. Add a description

Click the icon

on the toolbar to bring up the Patch Descriptors dialog. You are no doubt very proud of the 
patch you have created and want to replace the default Description field with your own 

personalized remark. Go for it. Press the  button when you are done to close the 
dialog.

A name for the instrument (up to 16 characters) can be entered in the Instrument Name 
box. This name can displayed by applications (such as UltraSound Patch Manager) to help 
identify the patch. "Violin" would be a reasonable choice for a name. You could also add a 
name for the current waveform.    By default it has the same name as the .WAV file it came 
from.

Click to  button when you are done to close the dialog and save the name.

13. Adjust the waveform range

Most instrument patches contain more than one waveform. Different waveforms are used to 
cover different ranges of notes, in order to achieve a higher quality of sound.    As it stands, 
our violin patch does not leave any room for other waveforms, because the single waveform 
we have covers the entire keyboard (as indicated by the fact that all the keyboard keys are 
yellow).

To make room for other waveforms, we will adjust the range of notes to be covered by the 
current waveform.    To do this move the mouse cursor over the right end of the red box 

until it changes into the shape . Press the left mouse button and hold it while you 
move the mouse to the left.    The yellow-colored region changes with the mouse 
movement.    Move the left hand side of the region similarly.

Your keyboard might look something like this when you finish:

If you try to play notes outside the range shown in yellow, you won't hear anything. You 
could now drop another waveform onto an uncolored part of the keyboard. Colors for 
waveform ranges alternate between yellow and blue.

15. View the patch information

Press the toolbar icon



to bring up the View Patch Information dialog. It lets you see how big the patch is, and 
information about the current waveform.

16. Congratulations!

Well done, you now know how to create new, high-quality patches for your UltraSound. This
is a good time to do some experimenting, if you haven't already. Open several patches and 
several wave files at once into Patch Maker's window. Add more wave waveforms to your 
patch. And of course, use the patch in making music or special effects!



How to Load an Existing Patch for Editing
There are three methods for loading a patch file into Patch Maker.

(1) Use the File | Open command.

(2) Drag and drop a patch file from the Windows File Manager into Patch Maker's main 
window. (See your Windows documentation for more information about drag-and-drop.) The
patch file extension must be .PAT. You can drop several files at the same time.

(3) Include the name of the patch file in the command that is used to start Patch Maker.    
For example, to load the patch file hello.pat when Patch Maker starts, you could create an 
icon with the command line 

pmaker.exe hello.pat



patch
A patch is a file that contains sound waveforms and associated information that is used to 
define an instrument sound for the UltraSound.



loop region
A loop region is a portion of a waveform that is played repeatedly to provide sound for a 
note whose duration is longer than the duration of the waveform.



File New
The New command creates an empty patch. You would use it if you want to create a new 
patch from scratch using waveforms. To edit an existing patch, use the File Open... 
command.



File Open...
Use the Open command to bring an existing patch into Patch Maker's window in order to 
test or modify it. You can also open patches by specifying them on the command line or by 
dragging and dropping them onto the Patch Maker window.



File Open .WAV File...
Use this command to open a waveform file. Later, this can later be added to a patch by 
dragging and dropping it onto a patch keyboard.

You can also open a waveform file by specifying its name on the command line when you 
run Patch Maker, and by dragging and dropping a file with the extension .WAV from the File 
Manager onto Patch Maker.



File Save
Use this command to save a patch that you have created or modified. Any changes you 
have made to the patch will then be permanent.



File Exit
Use the Exit command to leave Patch Maker. If you have modified any patches since they 
were last saved, you will be asked if you want to save them.



Edit Delete
Use the Delete command to remove the current waveform from the current patch.



Edit Remove Silence
The Remove Silence command can be used to eliminate periods of silence from the 
beginning and end of a waveform. It works on the current waveform by first doing an 
analysis to find the first and last sample points that are louder than a threshold (which is 
determined automatically). You are then given the option to delete the sample points 
outside that range.



Edit Maximize Volume
If the current waveform is too quiet, you can use the Maximize Volume command to 
increase its volume. The sample data is analysed to find the minimum and maximum 
values, then all points are multiplied by a factor which ensures that the maximum allowed 
range is used. 

At the same time, the average value of the samples is arranged to be zero (i.e., any DC 
offset is removed). This can help the patch sound better and avoid pops and clicks.

You are informed of the percentage by which the waveform volume will be increased, and 
asked to confirm that it is alright to proceed. Note that because of the DC offset removal, it 
can happen that the percent volume increase is negative.    This is an applicable value and 
can lead to a better sounding patch if accepted.



 Edit Loop Region
A waveform in a patch often has a loop region defined.    This dialog lets you interactively 
modify the loop region values to obtain high-quality sound that can have a long duration.

Defining the loop region

A loop region has a start point and a length, which can be set by their respective sliders 
marked coarse and fine.    As the names suggest, coarse lets you set the value to 
approximately where you want it and fine lets you fine tune the value for the best sound. 
You can not have a start point and loop length combination that would put the end of the 
loop region past the end of the sample data.    Thus the sliders may refuse to move beyond 
a certain point when you are dragging them to the right.

Getting loop parameters that result in a good sound can be tricky.    For many waveforms, 

the  button can help.    When you press this button, the sample data is 
analyzed (this may take a few seconds) and a minimum loop length to use is suggested.

After pressing the Suggest... button, its label changes to use and something like the 
following will appear:

In this example, the suggested minimum loop length is 127.909.    However, you can 
sometimes get better results by using a multiple of the minimum length.    In the example, 
the multiplier is set to 4 with a resulting loop length of 511 10/16.    If you press the Use 
button now, the loop length will be set to 511 10/16 samples, and the loop start point will 
be set as close to the end of the waveform as possible. Some fine tuning may still be 
needed, but the above procedure will often get you into the right ballpark.

Setting the loop type

The loop region can be played forwards, backwards or in both directions. The check boxes 
labelled Forward, Backward, Unidirectional and Bidirectional let you choose these options.

Enabling looping

When you bring up this dialog, the Enable Looping checkbox is checked by default. If you 
do not want the patch to play the loop region repeatedly, uncheck this box.



 Choose Envelope
This dialog lets you view or modify the envelope options for the current sample. 

The Sustain option lets you determine what happens when you have set a note on, but 
before you turn it off. For most percussion instruments, the notion of turning the note off 
does not apply, and you just want the sample to play through. For melodic instruments, you
typically want the note to continue playing (although perhaps at decreasing volume) until a
note off is sent.

The While note is on... options let you choose whether a note maintains a constant or 
decreasing volume until note off is sent. Note that if looping is not enabled, the note sound 
will play only for the duration of the sample in any case.

The When note is turned off... options let you choose how quickly the note volume 
decreases when a note off is sent.

Use the  button to interactively explore the effects of these options. You may need
to stop and re-start the note to hear the effect of some options.



 Adjust Tuning

This dialog lets you put the current waveform in tune. When you press the  
button, you will hear your waveform and a reference tone, which is at the pitch that your 
waveform should be at to be in tune.

You can interactively set the pitch while the note is playing by adjusting the slider labelled 
Sample Pitch. You can play either the waveform note or reference tone alone, or play them 
together by choosing the appropriate option under the Play/Stop button.

In many cases, you can press the  button to get some help in gettting the 
patch in tune. When you press 

, the sample data is analysed (this make take a few seconds) and a frequency is
suggested to put the sample in tune.    The label of the button changes to 

.    If you press the Use button, the suggested frequency will applied to the patch 
tuning values to affect its pitch.



 
 Edit Vibrato/Tremolo

This dialog lets you view or modify the vibrato (pitch variation) or tremolo (volume variation)
characteristics, respectively, of the current waveform. The effects of vibrato and tremolo are 
determined by the sweep, rate and depth of the effect. 

You can interactively set these values by pressing the  button and adjusting the 
sliders.    In some cases, you need to stop and re-start the note in order to hear the effect.



sweep
The sweep value for vibrato or tremolo determines how soon after the note is turned on 
that the effect takes place.    The larger the value of sweep, the longer the delay.



rate
The rate value for tremolo or vibrato determines how quickly the pitch or volume varies.



depth
The depth value for tremolo or vibrato determines how large the variation is.



 Edit Patch Descriptions & Names
This dialog lets you view and modify descriptions of elements of your patch.

Patch Description holds any text you want about the patch.

Instrument Name can hold the name of the instrument for this patch. This can be used by
other applications to help identify the patch.

Waveform Name can hold any name you wish to give to this waveform. By default, Patch 
Maker uses the name of the .WAV file that the waveform came from.



 Display Patch Information
This dialog shows some information about the patch data. None of this information is 
necessary to make patches, but is provided for the curious.

Total Patch Size is the total amount of UltraSound memory that will be taken up by the 
patch. It is usually a little larger than the sum of the sizes of each waveform in the patch, 
because the size of each waveform is rounded up the next multiple of 32.

Waveform Size This is the size (in bytes) of the current waveform.

Waveform Rate This is the sampling rate of the current waveform.

Type of Data Waveform data can be 8-bit or 16-bit, signed or unsigned.



Commands
File menu
    New
    Open
    Open .WAV File...
    Save
    Save As...
    Exit

Edit menu
    Delete
    Remove Silence
    Maximize Volume

Window menu
    Tile
    Cascade
    Arrange Icons
    Close All



Toolbar

 Display patch information

    Edit patch descriptors

 Edit loop region

 Choose envelope

 Adjust tuning

 Edit vibrato

 Edit tremolo

 Adjust balance

 "Panic button"



 Adjust Balance
This dialog lets you adjust the balance of the current waveform. Each waveform in a patch 
can have its own balance.



 Panic Button
The panic button reloads all patches that you are working on into UltraSound memory. There
are two situations where you might want to do this:

1. A note will not stop playing. (We have tried to prevent this from happening, but have 
provided the panic button, just in case.)

2. No sound, or incorrect sound, is heard when you play a patch note. This can happen for 
example if you run another program which uses the UltraSound while Patch Maker is 
running.    The other program may have loaded its own patches.



waveform
A waveform is a collection of samples of a sound. In Windows, waveforms are usually stored
in a file with .WAV extension. A patch for the UltraSound contains one or more waveforms 
which contain the sampled sounds of an instrument.

(Sometimes, people use the term sample and waveform interchangeably.)



sample
A sample is a single number representing one point in a digitized sound. (Sometimes the 
word sample and waveform interchangeably.)



envelope
The envelope of a waveform is a set of numbers that describe what volume each part of 
the waveform should be played at and whether the volume increases or decreases in each 
part.



sustain
If a waveform's envelope has sustain selected, a note will play through the first part of the 
envelope and then maintain a constant rate of increase or decrease of volume for as long 
as it is on. When the note is turned off,    the note plays through the remainder of the 
envelope.

If sustain is not selected, then a note will play through the envelope values without 
stopping until the end of the sample is reached.



root frequency
The root frequency of a waveform in a patch determines the pitch at which a note will play. 
The root frequency is normally the frequency that the note was played at when it was 
sampled. It might be different to allow for fine tuning of the note.

The note corresponding to the root frequency is shown as a red rectangle on the patch 
keyboard. It can be changed in the Adjust Tuning dialog.



note range
A single waveform in a patch is normally used to play several different notes in a range.    
The notes that a particular waveform applies to are known as a note range and are shown 
as colored regions (yellow or blue) of the patch keyboard.



File Save As ...
This menu command lets you save the current patch into a file with a different name.



Suggest...
When you press the Suggest... button in the Edit Loop Region or Adjust Tuning dialogs, 
Patch Maker analyses the current waveform to determine what values to use for the root 
frequency and the length of the loop region. Then the name of the button changes to Use.



Use
If you have pressed the Suggest... button in the Edit Loop Region or Adjust Tuning dialogs, 
then the name of that button changes to Use. If you press Use, the suggested value is 
used.



Window Tile
This command arranges the patch windows so that they do not overlap.



Window Cascade
This command arranges patch windows so that they overlap in an orderly fashion.



Window Arrange Icons
This command spaces any icons evenly in the main window.



Window Close All
This command closes all patch keyboard windows, patch keyboard icons and waveform 
icons.




